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Program Description
What is WinZip® Self-Extractor?
WinZip Self-Extractor is a utility program that creates native Windows and Windows 95 self-extracting ZIP
files.    These self-extracting ZIP files are ideal for electronic file distribution because they:    (1) can 
contain multiple compressed files, ensuring that important files do not become separated from the rest of 
the package; (2) allow the receiver to use a familiar Windows interface to decompress files, without 
owning or knowing how to use a separate unzip utility; and (3) optionally run a "setup" or "installation" 
program, which may be included by the developer when the files are decompressed. 
WinZip Self-Extractor is an optional add-on to WinZip®, an award winning utility to manipulate ZIP files.    
For more information on WinZip see the section titled About WinZip.
This portion of the documentation describes ZIP files and self-extracting ZIP files, discusses the benefits 
of self-extracting ZIP files, and summarizes WinZip Self-Extractor features.
What is a ZIP file? 
The ZIP file format is an industry standard for compressing and grouping files.    One ZIP file can contain 
multiple files.    Files contained in a ZIP are usually compressed.    
Typical uses for ZIP files include:

· Most files available in "file areas" on bulletin boards and electronic services like CompuServe and
the Internet are distributed as ZIP files.    Two benefits of using ZIP files for electronic file 
distribution are that only one file transfer operation ("download") is required to obtain all related 
files, and file transfer time is minimized because the files in a ZIP are compressed.

· It is often useful to send a group of related files to an associate.    Rather than distributing 
individual files it is often easier to distribute the files as a ZIP file to benefit from the file grouping 
and compression.

ZIP files are created using a ZIP utility like WinZip® or the PKZIP® utility from PKWARE®.
What is a Self-Extracting ZIP File?
A self-extracting ZIP file is an executable program file (.EXE file) that includes a ZIP file and software to 
extract or "unzip" the contents of the ZIP file.    Users can run (execute) a self-extracting ZIP file just as 
they run any other program.
When a self-extracting ZIP file created by WinZip Self-Extractor is run, a dialog box is displayed.    This 
dialog box makes it easy for the user to change the "unzip to" directory and change other options before 
extracting or "unzipping" the files in the self-extracting ZIP file.
Self-extracting ZIP files created by WinZip Self-Extractor    are

· 100% compatible with the PKZIP 2.04g file format, so they can be unzipped by standard unzip 
utilities like WinZip and PKUNZIP.

· Only about 12k larger than a regular (not self-extracting) ZIP file when using default options.
What are the advantages to Self-Extracting ZIP Files?
Users can extract or "unzip" files from a self-extracting ZIP file without running a separate unzip utility or 
knowing how to use an unzip utility.    Thus self-extracting ZIP files are particularly suited for distribution of 
software to beginning users who are not familiar with the concept of ZIP files.
Self-extracting ZIP files created by WinZip Self-Extractor are native Windows programs so they are easy 
to use even for users with no MS-DOS experience.
How Does it Work?
There are two parts to WinZip Self-Extractor:

1) The WinZip Self-Extractor program creates self-extracting ZIP files.
2) When WinZip Self-Extractor creates a self-extracting ZIP file it includes part of itself in the self-



extracting ZIP file.    The part of WinZip Self-Extractor included in the self-extracting ZIP file is 
what makes it possible to unzip the files by simply running the self-extracting ZIP file.

The person who creates the self-extracting ZIP file runs WinZip Self-Extractor once, specifying the name 
of the ZIP file and options, including the default "unzip to" directory and a program to be run automatically 
when the unzip operation completes.    WinZip Self-Extractor stores this information in the self-extracting 
ZIP file so it is available when the self-extracting ZIP file is run.    See the section titled Creating Self-
Extracting ZIP Files for details on the procedure, and the section titled Copyright/License/Warranty for 
information on licensing.
Summary Of Features

· Easy distribution of one or more compressed files.
· Low overhead (12k using default options).
· An optional comment (up to 512 bytes) is displayed when the self-extracting ZIP file is run.
· An optional command is run when the unzip operation completes, making it easy to run a SETUP 

program included in a self-extracting ZIP file.
· Any directory information in the ZIP is automatically restored.
· 100% compatible with the PKZIP 2.04g standard.

Association of Shareware Professionals Notice
This program is produced by a member of the Association of Shareware Professionals (ASP).    ASP 
wants to make sure that the shareware principle works for you.    If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, ASP may be able to help.    The 
ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products.    Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442 or send a CompuServe message to the ASP Ombudsman at 70007,3536.



Copyright/License/Warranty
Copyright
WinZip® Self-Extractor Copyright © 1995 by Nico Mak Computing, Inc.
All rights reserved.

License Agreement
You should carefully read the following terms and conditions before using this software.    Unless you have
a different license agreement signed by Nico Mak Computing, Inc., your use of this software indicates 
your acceptance of this license agreement and warranty.
For information on distributing the shareware evaluation version of WinZip Self-Extractor see the section 
titled Shareware License.
Registered Version
Each registered copy of WinZip Self-Extractor may be used at a single workstation to create an unlimited 
number of self-extracting ZIP files, subject to the following conditions:

· A separate registered copy of WinZip Self-Extractor must be obtained for each workstation on 
which WinZip Self-Extractor will be used to create self-extracting ZIP files, even if such use is only
temporary.    This is not a "concurrent use" license.

· Self-extracting ZIP files created by WinZip Self-Extractor contain, among other things, a portion of
WinZip Self-Extractor, including copyrighted software, proprietary notices, and identifying 
information (the "Extraction Software").    No registered user, nor anyone else, may alter or modify
the Extraction Software.    You cannot give anyone else permission to modify the Extraction 
Software.

All rights not expressly granted in this license agreement are reserved entirely to Nico Mak Computing, 
Inc.
Governing Law
This agreement shall be governed by the laws of the State of Connecticut.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.    Because of the various hardware and software environments 
into which WinZip Self-Extractor may be put, NO WARRANTY OF FITNESS FOR A PARTICULAR 
PURPOSE IS OFFERED.
Good data processing procedure dictates that any program be thoroughly tested with non-critical data 
before relying on it.    The user must assume the entire risk of using the program.    ANY LIABILITY OF 
THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF 
PURCHASE PRICE.



Shareware License
Evaluation and Registration
This is not free software.    You are hereby licensed to use the shareware evaluation version of WinZip 
Self-Extractor for evaluation purposes without charge for a period of 21 days.    If you use this software 
after the 21 day evaluation period a registration fee is required, as described in the WinZip Self-Extractor 
order form.
Under no circumstances are you licensed to distribute self-extracting ZIP files created by the shareware 
evaluation version of WinZip Self-Extractor.
Unregistered use of WinZip Self-Extractor after the 21-day evaluation period is in violation of U.S. and 
international copyright laws.
Distribution of WinZip Self-Extractor
You are hereby licensed to make as many copies of the shareware evaluation version of this software and
documentation as you wish; give exact copies of the original shareware version to anyone; and distribute 
the shareware version of the software and documentation in its unmodified form via electronic means.    
There is no charge for any of the above.    
You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission, with one exception:    Disk Vendors approved by the 
Association of Shareware Professionals are permitted to redistribute WinZip Self-Extractor, subject to the 
conditions in this license, without specific written permission.



Licensing Questions and Answers
The following questions have come up a few times:
Question: I licensed WinZip; why do I need a separate license for WinZip Self-Extractor?    After all, when
I buy PKZIP I get a license to distribute DOS self-extracting ZIP files made with ZIP2EXE.
Answer: This is a popular misconception.    Distribution of self-extracting ZIP files created with ZIP2EXE 
2.04g requires a special "distribution license" from PKWARE.    A distribution license is NOT included with 
the registered PKZIP package.    Here is an extract from the text displayed when you run a self-extracting 
ZIP file created with the registered version of ZIP2EXE and specify the -l (license) parameter:

For use on multiple machines or to use to distribute your 
information or software, a separate license is required.    See the 
file LICENSE.DOC for further information.

The LICENSE.DOC file states that you must need to fill out an "Application for Distribution License" to 
receive a quotation before distributing self-extracting ZIP files created with PKZIP and ZIP2EXE.
Question: Why does WinZip Self-Extractor cost more than WinZip?
Answer: Many people can run the self-extracting ZIP files created by one copy of WinZip Self-Extractor, 
while only one computer can unzip files using a single licensed copy of WinZip.    Thus, while it is true that
a one-computer license to create self-extracting ZIP files is more expensive than a one-computer license 
to use WinZip, if many receivers unzip your self-extracting ZIP files, the charge per receiver is far less 
expensive when using WinZip Self-Extractor.    Remember that every time you send a self-extracting ZIP 
file to others you also distribute parts of the copyrighted executable unzip software.



Order Form
WinZip(R) Self-Extractor Registration Form/Invoice
*** NOTE:  At the time of this writing (December 19, 1995) ***
*** WinZip Self-Extractor 1.1 has not been released.  If   ***
*** you order WinZip Self-Extractor before version 1.1 is  ***
*** released you will receive a disk with WinZip           ***
*** Self-Extractor 1.0 and a registration number you can   ***
*** use to create re-distributable self-extracting ZIP     ***
*** files with the pre-release beta version of WinZip      ***
*** Self-Extractor 1.1.  When WinZip Self-Extractor 1.1 is ***
*** released you will be able to download a free upgrade.  ***
To print this order form, click on Print Topic in the File pull-down menu.    
Ordering by check:    To order by check send this order form and a check to "WinZip Self-Extractor", 
Nico Mak Computing, Inc., P.O. Box 919, Bristol, CT 06011, USA.    Payments must be in US dollars 
drawn on a US bank, or you can send international postal money orders in US dollars.
Credit card ordering:    For information on ordering by MasterCard, Visa, American Express, or Discover 
by phone, FAX, or CompuServe email, or postal mail, click here: Credit Card Ordering.
CompuServe Registration:    To have the registration fee added to your CompuServe bill type GO 
SWREG at the ! prompt and register product ID 4866.
Purchase Orders:    For information on using purchase orders click here: Purchase Orders.
Prices guaranteed through January 1996.
WinZip Self-Extractor is shipped on 3.5" disks only.
Single Copy  ____  copies at   $49 each     = ______
Five-Pack    ____  5-packs at $199 each     = ______
  A Five-Pack includes ONE copy of the
  software and a license to duplicate the
  software as needed to create self-
  extracting ZIP files on up to five
  workstations at one organization.
Connecticut residents add 6% sales tax      + ______
                         Total payment        ______
Please be sure to print clearly!  Your organization name is required and will 
be imbedded in all self-extracting ZIP files created by your registered copy 
of WinZip Self-Extractor.
            Name: ______________________ Date:___________
    Organization: _______________________________________
         Address: _______________________________________
City, State, Zip: _______________________________________
         Country: _______________________________________
       Day Phone: ______________  Eve:  _________________
Electronic Mail address:  _______________________________
How did you hear about this product? ____________________
Comments:



Credit Card Ordering Information
To print this order form, click on Print Topic in the File pull-down menu.    
MasterCard, Visa, American Express, and Discover orders for WinZip Self-Extractor must be placed 
through PsL.    The best way to reach PsL is by fax to 1-713-524-6398 or by CompuServe mail to 
71355,470 or Internet mail to 71355.470@compuserve.com.    You can also call PsL at 1-800-242-
4PsL(4775) or 1-713-524-6394 between the hours of 7:00 am and 6:00 pm CST Monday-Thursday and 
7:00 am and 12:30 PM CST on Fridays, except holidays.
Credit card orders can be mailed to PsL at P.O. Box 35705, Houston, TX 77235 USA.
PsL requires the following information:
Credit Card [ ] MasterCard [ ] VISA [ ] AMEX [ ] Discover
Credit Card Number: _____________________________________
Expiration Date:    _____________________________________
Name On Card:       _____________________________________
Billing Address:    _____________________________________
                    _____________________________________
                    _____________________________________
PLEASE INCLUDE THE STANDARD WINZIP SELF-EXTRACTOR ORDER FROM THE PREVIOUS 
PAGE WITH YOUR ORGANIZATION NAME ETC
Nico Mak Computing, Inc. cannot be reached at the numbers above.
These numbers are for PsL, a credit card order taking service only.
Any questions about the status of the shipment of an order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, etc., must be directed to Nico Mak 
Computing, Inc., P.O. Box 919, Bristol, CT 06011, USA or by CompuServe mail to 70056,241 or by 
Internet mail to 70056.241@compuserve.com.



Purchase Orders
Purchase orders (net 30 days) are accepted only from government and accredited educational institutions
and major corporations, provided that they are submitted on purchase order forms with a purchase order 
number.    Purchase orders should be sent to Nico Mak Computing, Inc., P.O.    Box 919, Bristol, CT 
06011.    Please be sure to include the standard WinZip Self-Extractor order form with a purchase order.    
The Federal Tax Id for Nico Mak Computing, Inc is 06-1378727. Due to the extra work involved in 
processing purchase orders you are encouraged to use a credit card, CompuServe's SWREG registration
service, petty cash, or an expense account when possible for small orders.



Technical Support
Technical support is available at no charge.    Support options are:

CompuServ
e:

enter GO WINZIP and leave a message in the WinZip section, 
or send email to 70056,241

Internet: send email to support@winzip.com
Postal Mail: write to "Technical Support", Nico Mak Computing, Inc., P.O. 

Box 919, Bristol, CT 06011 USA

Solutions to two common problems
1) If someone downloads a self-extracting ZIP file and reports that they get the system message 

"out of memory" when trying to run it, the reason is usually that the file was corrupted during the 
file transfer.    Both DOS and Windows often issue "out of memory" errors when you attempt to 
execute invalid executable files.    Usually the best solution to this problem is for the user to obtain
another copy of the self-extracting ZIP file. 

2) If the WinZip Self-Extractor dialog box is not displayed when a user runs a self-extracting ZIP file, 
the reason is usually that an EXE, FON, DLL, or DRV file with the same is already running on the 
user's system.    For example, if you create an EXE file called USER.EXE, you will not be able to 
run it because Windows automatically loads a file called USER.EXE, and Windows does not 
allow you to run two different files with the same name.    WinZip Self-Extractor checks for 
conflicts on your machine when you create a self-extracting ZIP file, but it is of course impossible 
to check for conflicts on your users machine.    A simple solution to this problem is to rename the 
self-extracting ZIP file.

Hints
1. When running WinZip Self-Extractor from a BAT file or "make" file under Windows 95 you can 

wait for WinZip Self-Extractor with the command
START /WAIT WINZIPSE.EXE -y [other options] filename.zip

2. Self-extracting ZIP files can optionally display a message box when they are started, before the 
main dialog box is displayed (normally this comment is in the file winzipse.diz, but you can specify
a different filename with the -m command line parameter).    Formatting the text in this message 
box can be tricky: the exact size of the message window varies depending on your video 
configuration, so the text should only contain carriage returns and line feeds when you want a 
blank line to separate text.    One way to create this file is as follows:
· Run Notepad (normally in the "Accessories" group)
· Check the "Word Wrap" entry in the Edit pull-down menu
· menu if it is not already checked
· Type the text WITHOUT pressing the Enter key to end a line. In other words, let the "Word 

Wrap" feature wrap the text. Press the Enter key ONLY when you want a blank line to 
separate text; in that case press the Enter key TWICE.

· Resize the Notepad window to a few different sizes to be sure the text looks "right", then save
the file.

Technical Details
· WinZip Self-Extractor creates 16-bit self-extracting ZIP files.    Long name support is provided by 

the new interrupt 21 functions for long filenames.    These functions are not available under the 
Intel version of Windows NT 3.51.



About WinZip
WinZip Self-Extractor is a companion product to WinZip.    WinZip is an award-winning utility that brings 
the convenience of Windows to the use of ZIP files.    WinZip includes built-in PKZIP compatible ZIP and 
UNZIP, so PKZIP and PKUNZIP are not needed for basic archive operations, and features an intuitive 
point and click interface for viewing, running, extracting, adding, deleting, and testing files in archives.    
Optional virus scanning support is included.
Here's what the magazine reviews say about WinZip:

· "Cadillac of unzippers", PC Magazine 3/15/95
· "For the price and all the services it provides, anyone using .ZIPped files today cannot go wrong 

with this program", Windows Sources 7/94
· "Must Buy" rating, PC Laptop, 7/94
· "Slick and Intuitive", Computer Shopper, 5/94
· "Easy to use", InfoWorld, 4/18/94
· "It's this simple: Those who use PKZIP and Windows should get a copy of WinZip 5.0", PC 

Computing, 12/93
· One of the "Top 10" Windows Utilities, CompuServe Magazine, 10/93
· One of the "20 Must-Have Windows Utilities", Windows User, 6/93
· "Archive Manager Extraordinaire", Windows Sources, 5/93
· "WinZip 4.0 improves on an already impressive product, making archiving a simple task for 

Windows users", Windows User, 5/93
· WIN100 Award Winner, Windows Magazine, 2/93
· "Repeatedly charms you when you have to ZIP and unZIP ... an excellent Shareware utility", 

Windows Magazine, 12/92
· "Our copy gets quite a daily workout", Windows User, 11/92
· "The most comprehensive Windows front-end to PKZIP", Ziffnet Threads, 11/92
· "Does all your compression chores with ease", Computer Shopper, 10/92
· "Must-Have Shareware Treasure", Compute, 10/92
· "The perfect Windows interface for LHA, PKZIP, ARC, and your favorite DOS virus scanner", PC 

World, 10/92
· "Greatly facilitates archive management", Windows Magazine, 9/92
· "Powerful yet Intuitive", PC World, 8/92
· "Hot Product", Inside Microsoft Windows, 8/92
· "WinApp of the Month", PC Computing, 3/92

You can download an evaluation copy of WinZip from many bulletin boards (look for the file winzip*.*), or 
on CompuServe by typing GO WINZIP and downloading winzip.exe from the WinZip library, or on the 
Internet as winzip*.exe from the winzip directory at ftp.winzip.com.    WinZip's World Wide Web home 
page is http:/www.winzip.com



Version History
The only change in WinZip Self-Extractor 1.1 is optional Windows 95 long filename support and built-in 
support for the German language header.    Additional enhancements are planned for the future.
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System Requirements
The documentation assumes you know how to use Windows, and know how to create ZIP files.    WinZip®
Self-Extractor does not create ZIP files, so you need a utility like WinZip that creates ZIP files.    Finally, 
you need Microsoft Windows 3.1, Windows 95, or a compatible system.



WinZip Self-Extractor Distribution Files
Filename Description
README.TXT introductory information
LICENSE.TXT license agreement/warranty
WINZIPSE.TXT extracts from online documentation
WINZIPSE.HLP documentation in online hypertext help format
WINZIPSE.EXE required executable (Windows version only)
ORDER.TXT order form
WHATSNEW.TXT list of recent changes
FILE_ID.DIZ brief description for bulletin boards
VENDOR.TXT information for Shareware Distributors and Disk Vendors
SETUP.EXE installation program

Installation
To install WinZip® Self-Extractor simply run the SETUP program on the distribution disk and follow the 
prompts.    This will install the files and create a program group called WinZip Self-Extractor.



Uninstallation
Uninstalling WinZip® Self-Extractor is fairly simple. Here are the steps involved under Windows 3.1:

1. Using the Windows File Manager or some other utility, delete the WinZip Self-Extractor directory 
and all of the files it contains.

2. Delete WinZip Self-Extractor's icons, which are installed in a Program Manager group called 
WinZip Self-Extractor.    To do this, activate the WinZip Self-Extractor group and then press the 
Delete key repeatedly until all of the icons have been deleted. After the group is empty, you can 
press the Delete key one more time to delete the group itself.



Creating Self-Extracting ZIP Files
To create a self-extracting ZIP file first run WinZip® Self-Extractor.    You can do this in one of three ways:

1. Run WinZip Self-Extractor from the Program Manager.    Just double click on the WinZip Self-
Extractor icon in the WinZip Self-Extractor program group or Start Menu, and fill in the fields in the
main WinZip Self-Extractor Window.

2. Run WinZip Self-Extractor directly from WinZip 6.0 or later.    Just select Make EXE File from the 
WinZip Options menu and fill in the fields in the main WinZip Self-Extractor Window.    Before 
doing this you must first specify the full filename (including directory information) of WinZip Self-
Extractor in the Make EXE field in the WinZip Options/Program Locations dialog box.    When 
WinZip Self-Extractor is run for the first time on your system it will offer to do this for you if it 
detects WinZip 6.0 installed on your system.

3. Run WinZip Self-Extractor from the DOS prompt:    Command line options are required for this 
choice.    For a list of options see the section titled Command Line Options.

Displaying a comment when the self-extracting ZIP file is run
If the file WINZIPSE.DIZ exists in the directory of the ZIP being processed, the first 512 bytes of the 
contents of the DIZ file will be displayed in a message box when the self-extracting ZIP file is run.    Be 
sure to use a Windows based editor like NOTEPAD when creating this file if you include special 
characters or foreign characters, since this file is displayed using the Windows character set.    You can 
specify a different comment filename with the -m command line option.    Formatting tips are in the hints 
portion of of the section titled Technical Support.
Notes:

· When the self-extracting ZIP is run any directory information stored in the ZIP will automatically 
be used.

· WinZip Self-Extractor does not handle password protected ZIPs or ZIPs that span disks.
· Since WinZip Self-Extractor is a 16-bit Windows program it does not handle long filenames.
· A "Large Model" version of WinZip Self-Extractor that takes a bit more disk space and provides 

more features is planned.    These features will probably include: a browse dialog box to select the
Unzip To directory, support for ZIP comments, an Overwrite All button in the overwrite prompt, 
etc.



The Main WinZip Self-Extractor Window
When you start WinZip® Self-Extractor a dialog box with the following fields is displayed:

· The name of the ZIP file to turn into a self-extracting ZIP file.    You can either type the name, or 
press the Browse button and use the standard Open dialog box to select a ZIP file.    Alternately, 
you can use the standard File Manager drag and drop interface to drop a ZIP onto WinZip Self-
Extractor, or, if you have installed WinZip Self-Extractor in WinZip, simply select Make .EXE File 
from a WinZip window.

· The default target directory for the unzip operation.    If left blank the directory specified by the 
user's TEMP= environment variable is used.    This is generally the best choice if your ZIP file 
contains a SETUP program that will copy the unzipped contents of the ZIP to another directory.    
If you do not have a SETUP program you will probably want to choose a name related to the 
contents of the ZIP.    For example, you might use "c:\modem" for a ZIP containing a help file 
called "modem.hlp".    This field is the equivalent of the -d command line option.

· The optional command to execute when the unzip operation completes.    This command will be 
issued from the user's Unzip To Directory, so directory information is generally not needed in 
this command.    The Windows WinExec API is used to run this command.    Typical commands 
are:
· SETUP - to run the SETUP program in the ZIP file
· WINHELP myfile.HLP - to start the Windows HELP engine on a file in the ZIP
· NOTEPAD myfile.TXT - to start NOTEPAD on a file in the ZIP
This field is the equivalent of the -c command line option.

· Four types of self-extracting ZIP files can be created:
1. Windows 3.x - no long filename support. This option creates self-extracting ZIP files without 

long filename support.    Any long filenames in a ZIP will be truncated when they are 
extracted. (Historical note: these files are almost identical to those created by WinZip Self-
Extractor 1.0).

2. Windows 3.x or 95 - with long filename support. This option enables long filename support; 
however, if these self-extracting ZIP files are run on a system without this support a message 
box is displayed warning the user of potential problems, and any long filenames will be 
truncated.    This message box is displayed after the optional comment message box.

3. Windows 95 required - with long filename support. This option creates self-extracting ZIP files
that REQUIRE a system with Windows 95 compatible long filename support.    If these self-
extracting ZIP files are run on a system without this support the standard system message 
"This program requires a later version of Windows" is issued.

4. MS-DOS and Windows 3.x - no long filename support.    This option creates self-extracting 
ZIP files that can be run either from Windows or from the MS-DOS prompt.

These options correspond to the -31, -31LN, -95, and -DOS command line options.
· Whether the CTL3D.DLL should be used to generate 3D effects for the self-extracting ZIP file.    

CTL3D.DLL is used by many applications to generate 3D effects so there is a good chance it will 
exist on a lot of target systems.    If this option is specified WinZip will try to load CTL3DV2.DLL, 
and if not found, will try to load CTL3D.DLL.    Note that there is no way for WinZip Self-Extractor 
to guarantee that the CTL3D*.DLL on the target system will function properly.    This field is the 
equivalent of the -3 command line option.

Press the Make EXE button to create the self-extracting ZIP file.    Be sure to test the ZIP file before 
distributing it.    If your ZIP contains long filenames be sure to test under both Windows 3.x and Windows 
95 unless using the “Windows 95 required” option.



Command Line Options
Command line options are required when running WinZip Self-Extractor from the DOS prompt .    With the 
exception of the -m option, these options correspond to the fields detailed in the section titled The Main 
WinZip Self-Extractor Window.    The command line format is:
winzipse[.exe] filename[.zip] [options]
Where valid options are:
-3 Use CTL3D.DLL for 3D effects if available on the target 

system.
-c <command> Default command to execute after unzip operation completes.  

If specified this option must be last.
-d <directory> Default "unzip to" directory.
-m<fileid> Message (comment) file displayed when self-extracting ZIP is 

run.    The default is WINZIPSE.DIZ if it exists in the directory 
containing the ZIP file.

-y Automatically respond "yes" to the "overwrite file" prompt
-31 Windows 3.x self-extracting ZIP with no long filename support.

This option creates self-extracting ZIP files without long 
filename support.    Any long filenames in a ZIP will be 
truncated when they are extracted.

-31LN Windows 3.1 self-extracting ZIP with Long Name support. This
option enables long filename support; however, if these self-
extracting ZIP files are run on a system without this support a 
message box is displayed warning the user of potential 
problems, and any long filenames will be truncated.    This 
message box is displayed after the optional comment 
message box.

-95 Windows 95 self-extracting ZIP. This option creates self-
extracting ZIP files that REQUIRE a system with Windows 95 
compatible long filename support.    If these self-extracting ZIP 
files are run on a system without this support the standard 
system message "This program requires a later version of 
Windows" is issued.

-DOS MS-DOS and Windows 3.x self-extracting ZIP. This option 
creates self-extracting ZIP files that can be run either from 
Windows or from the MS-DOS prompt.

-LE Language English
-LG Language German

Example of usage:
C> winzipse filename -d c:\modem -c winhelp modem.hlp
This command turns filename.zip into a self-extracting ZIP file called filename.exe.    The default "unzip to"
directory is "c:\modem" and the command that is automatically executed after the unzip operation 
completes is "winhelp modem.hlp".
Note: when command line options are specified the main WinZip Self-Extractor Window is not displayed. 



Running the Self-Extracting ZIP File
To extract or "unzip" files in a self-extracting ZIP file simply run the EXE file.    Two ways to do this are:

1. Activate the Program Manager, select Run from the File pull-down menu, type the full filename of 
the self-extracting ZIP file, and press the Enter key.

2. Activate the File Manager and double click on the self-extracting ZIP file.
When the self-extracting ZIP file is run a dialog box is displayed with options to control

· The directory to which files are unzipped.
· Whether files are overwritten automatically or whether prompts are issued before each file is 

overwritten.
· Whether to run the optional command which was specified when the ZIP was created.    This 

check box is hidden if no optional command was specified.
The Unzip button unzips all files to the specified directory.
The Run WinZip button opens the self-extracting ZIP file with WinZip (assuming WinZip is installed on 
your system).    This gives you the ability to extract and view individual members, create a program group,
move the archive, etc.
The Close, About, and Help buttons close the Self-Extracting ZIP, display copyright information, and 
display basic usage information, respectively.



Register WinZip Self-Extractor
Please enter your organization name and registration number exactly as you received them from Nico 
Mak Computing, Inc.    You cannot substitute a different spelling or different organization name.    If 
the organization name needs to be changed (for example, due to a spelling error) please write to the 
address in the About dialog box with the replacement information, and you will receive a new registration 
number.
Your organization name will appear in the main window displayed when self-extracting ZIP files created 
by your copy of WinZip Self-Extractor are run.

 




